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Tips/Tricks demonstrated in 

The Maitland session

Change cell values using Paste XE "Paste"  Special XE "Special" 
Question:

I have a price list stored in a worksheet, and I need to increase all prices by 5 percent. Can I do this without re-entering all the prices?

Excel provides two ways to accomplish this:

The "common" technique goes something like this: 

Long Method XE "Method" 
1. Insert or find a blank column near the prices. 

2. In that column's first cell, enter a formula to multiply the price in that row by 1.05. 

3. Copy XE "Copy"  the formula down the column. 

4. Select and copy the entire column of formulas 

5. Select the original prices, and choose Edit, Paste XE "Paste"  Special XE "Special" . 

6. In the Paste XE "Paste"  Special XE "Special"  dialog box, select Values XE "Values"  to overwrite the original prices with the formulas' results. 

7. And finally, delete the column of formulas.  

The other, more efficient approach also uses the Paste XE "Paste"  Special XE "Special"  dialog box. To increase a range of values (prices, in this example) by 5 percent:
Shortcut Method XE "Method" 
1. Enter 1.05 into any blank cell. 

2. Select the cell and choose Edit, Copy XE "Copy" . 

3. Select the range of values and choose Edit, Paste XE "Paste"  Special XE "Special" . 

4. Choose the Multiply option and click OK. 

5. Delete the cell that contains the 1.05.
Fill XE "Fill"  blanks in a list

You've probably seen an Excel worksheet (like the sheet on the left, below) in which one entry in column A applies to several rows of data. Sort such a list and you get a real mess, because rows with empty cells in the sort column move to the top or bottom (depending on the sort order).
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When a list is small, you can enter the missing cell values manually. But if your database is huge, you need a better way of filling in those cell values. Here's how:

1. Select the range that contains blank cells 

2. Press Ctrl-G to get the Go To dialog box. 

3. In the Go To dialog box, click Special XE "Special" . 

4. Select the Blanks XE "Blanks"  option. 

5. Type = followed by the address of the first cell with an entry in the column (=A5 in the example above), and press Ctrl-Enter. 

6. Reselect the range and choose Edit, Copy XE "Copy" . 

7. Then select Edit, Paste XE "Paste"  Special XE "Special" , choose the Values XE "Values"  option, and click OK. 
The missing entries will be filled in, as in the sheet on the right in the above figure.
DateDif () – The secret Excel function
This function is not listed in Excel and does not even appear in its help files. Although Excel recognises it, there is strangely no supporting documentation about it. The syntax for the DATEDIF() function is as follows:

=DATEDIF ( EARLY DATE , RECENT DATE , "INTERVAL" )
The interval argument can be one of five options which specifies the result of the formula by the interval supplied.

“y” = year

“m” = month

“d” = day

“ym” = remainder of months within a year : eg: 12 years and 7 months
“md” = remainder of days within a month : eg: 7 months and 23 days
Highlighting XE "Highlighting"  Rows XE "Rows"  by Condition

The worksheet below shows student grades on two tests. Conditional XE "Conditional"  formatting highlights students who scored higher on the second test. This formatting is dynamic; if you change the test scores, the formatting adjusts automatically.
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To apply conditional formatting

1. Select range A2:C10 and choose Format XE "Format" , Conditional XE "Conditional"  Formatting.
2. The Conditional XE "Conditional"  Formatting dialog box will appear with two input boxes.
In the first box, choose Formula XE "Formula"  Is, press Tab, and enter the following formula:
=$C2>$B2 

3. Click Format XE "Format"  and choose a format to distinguish the cells (the example uses background shading).

4. Click OK, and the formatting will be applied.

The conditional formatting formula is evaluated for each cell in the range. The trick here is to use mixed cell references (the column references are absolute, but the row references are relative). To see how this works, activate any cell within the range and choose Format XE "Format" , Conditional XE "Conditional"  Formatting so you can examine the conditional formatting formula for that cell. You'll find that cell A7, for example, uses this formula:

=$C7>$B7.

Alternate XE "Alternate"  row shading using Conditional XE "Conditional"  Formatting

One way to make your data legible is to apply cell shading to every other row in a range. Excel's Conditional XE "Conditional"  Formatting feature (available in Excel97 or later) makes this a simple task.

1. Select the range that you want to format 

2. Choose Format XE "Format" , Conditional XE "Conditional"  Formatting 

3. In the Conditional XE "Conditional"  Formatting dialog box, select Formula XE "Formula"  Is from the drop-down list, and enter this formula: 
=MOD(ROW(),2)=0. 

4. Click the Format XE "Format"  button, select the Patterns tab, and specify a colour for the shaded rows. 

5. Click OK twice to return to your worksheet. 

The best part is that the row shading is dynamic. You'll find that the row shading persists even if you insert or delete rows within the original range.
Sorting by Formula

I have frequently had the need to sort by characters that occur in the middle of a string. I.e., the 2 numbers representing the month of birth within an ID number! Is there any way this can be done?

Yes, there is! To sort a list by characters in the middle of a text or number string, you need to extract the characters using some text formulas. Once the characters are extracted, you can sort the result of the extraction to update the list. Follow this generic method below as an example:

To extract and sort the CAPITAL letters in the Emp. No. do the following:

1. [image: image1.wmf]Select cell D2 directly next to the list.

2. Type =MID(A2,8,3) and press Enter.
The MID function extracts characters from the middle of a string using arguments as follows; A2 is the text where the characters must be extracted, 8 is the start position of the first character, i.e. the W, and 3 is the amount of characters to extract.

3. Autofill the formula for the rest of the list.

4. Sort the formulas results to update the list.
Comparing XE "Comparing"  Lists XE "Lists"  

Have you ever had two lists to compare using Excel? Here is one technique you can use that requires neither VBA XE "VBA"  nor array formulas - just a few straightforward worksheet functions. 

In this example we will assume that you have a MASTER LIST of companies (column A). Then you will have a second list of companies (column D) to compare to the MASTER LIST. We want to know which items in the second list are NEW companies and which ones already exist in the MASTER LIST. We will do this using some formulas in column F where the results will displayed.
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This is accomplished by using a combination of the VLOOKUP and ISNA worksheet functions.

Enter the following formula in cell F2:
=ISNA(VLOOKUP(D2,A:A,1,FALSE))

Copy XE "Copy"  this formula down through the last row in the column adjacent to the list of possible NEW items.


Let's break this down to see what this is doing.

=VLOOKUP(D2,A:A,1,FALSE)

First, we're using the VLOOKUP function to try to find each individual item from the second list (column D) anywhere within the MASTER LIST. In other words, this part of the formula says: Look at the list in column A and determine if there's a match on the entry in cell D2. 


If a city was not found in the MASTER list, then the VLOOKUP returns a #N/A error. That's okay though, because the next part of our formula looks at whether or not we got this error. To do this, we have nested the VLOOKUP into an ISNA function. 

=ISNA(VLOOKUP(C2,A:A,1,FALSE))

The ISNA function will return either a TRUE or FALSE. This part of the formula says: If the VLOOKUP function returns a #N/A error then it's TRUE, otherwise it tested FALSE for the #N/A error. 


So, whenever the formula returns a TRUE, it means that item from the second list is NEW - it does not exist already in the MASTER LIST. Likewise, if the result in column D is a FALSE, it means this item was already included in your MASTER LIST.

Double-click the Fill XE "Fill"  Handle XE "Handle"  to Automatically Fill Data XE "Data" 
You can double-click the fill handle of a selected cell to fill the contents of the cell down a column for the same number of rows as the adjacent column. For example, if you type data in cells A1:A20, type a formula or text in cell B1, press ENTER, and then double-click the fill handle, Microsoft Excel fills the data down the column from cell B1 to cell B20.
Custom Views (Outlines) XE "Data" 
To compact down a big or detailed sheet of data, one can use outlines or custom views.
Outlines
1. Activate the sheet that contains the data.

2. Select the Data Menu, choose Group and Outline

3. Select Auto Outline.

4. Use the outline numbers and markers in the sheet to control the amount of detail to view.

To remove the outline, choose Data : Group and Outline : Clear Outline

Custom Views

1. Use various methods to adjust the sheet to the view you want to create

a. Hide rows and columns,

b. Apply filtering techniques to collect data

c. Apply page setup (which is preserved in the view)

2. Once the layout and info is correctly displayed choose the View Menu

3. Select Custom Views

4. Give the view a name

5. Choose OK

6. Repeat the process for additional views.

Once the views are set, you can switch between them using the View : Custom Views Dialog

Summing XE "Summing"  times that exceed 24 hours

Question:

I have a range of time values, but when I try to sum them, the total is never greater than 24 hours.   

When you add a range that contains time values, Excel ignores the hours that exceed 24. The solution is to use a custom number format.

1. Activate the cell that contains your total time 

2. Choose Format XE "Format" , Cells. 

3. In the Format XE "Format"  Cells dialog box, click the Number tab. 

4. Choose Custom XE "Custom"  from the Category list 

5. Type [h]: mm into the box labelled Type. 

Using brackets around the hour portion of the format string tells Excel to display hours that exceed 24 hours 

Sorting XE "Sorting"  by Custom XE "Custom"  Lists XE "Lists"  in Microsoft Excel

Sorting XE "Sorting"  by row is the default setting, and sorting by column is performed alphabetically, in either ascending or descending order. 

Occasionally, you will want to sort data according to different criteria, for example, by a list of months – January, February, March, etc., or according to a list of employees in some order other than alphabetical. A list of this kind is saved in Custom XE "Custom"  Lists XE "Lists" .

If a Branch field contains four items – Western B, Southern B, Northern Territory and Eastern Quarter. The data should be sorted as follows – Northern Territory, Western B, Eastern Quarter, Southern B (not alphabetically), to change the sort order follow the steps.
Step 1 – saving a custom list

1. In a new sheet, in Cells A1:A4, enter the following items in this order – Western B, Southern B, Northern Territory and Eastern Quarter. 

2. From the Tools menu, select Options, and then select the Custom XE "Custom"  Lists XE "Lists"  tab. Click in the Import XE "Import"  box and select the cells containing a list of entries that matches the order for your new sort. If you do not have a list, type the entries in with the order that you want to sort in.
3. Click Import or OK XE "Import" . 

Step 2 – sorting by a custom list
1. Select one of the cells in the list. 

2. From the Data XE "Data"  menu, select Sort, and then Options. In the First key sort order drop-down list, select the list you saved in Step 1. 

3. Click OK. 

4. In the Sort dialog box, select Sort by, and then select the sort column. 

5. Click OK. 

Copying XE "Copying"  summary of Subtotals XE "Subtotals"  in Microsoft Excel

Problem: 
You cannot use the standard copy-and-paste techniques to copy a summary of subtotals. If you copy and paste the summary of Subtotals XE "Subtotals" , all of the data, including the hidden rows of data, are copied.

Solution XE "Solution" : 
Select the visible cells before copying. 

1. Be sure that the rows of data are hidden and that only the summary of the subtotals is visible on the sheet. 

2. Select a cell in the data region, and press Ctrl+*. To select visible cells, press Alt+; or press F5 and in the Go To dialog box, click Special XE "Special"  in the Go To Special dialog box, select Visible cells only. 

3. Click OK. 

4. Copy XE "Copy"  and Paste XE "Paste"  the summary of the Subtotals XE "Subtotals"  into a different sheet. Only the values of the data are pasted.

Adding XE "Adding"  Pictures XE "Pictures"  to Comment XE "Comment"  in Microsoft Excel

A picture can be included in a Comment and add additional functionality into a workbook list. I.E. to store a photo of a product or employee near the cells that contain that specific information?
1. Select a cell that contains a Comment XE "Comment" , right-click, and from the shortcut menu, select Show Comment. 

2. Select the edge of the Comment XE "Comment"  so that the Comment is surrounded by dots, not by slashes. 

3. Right-click, and from the shortcut menu, select Format XE "Format"  Comment XE "Comment" , Colours and Lines, Fill XE "Fill" . 

4. Open XE "Open"  the Colour box. Choose Fill XE "Fill"  Effects. Click the Picture XE "Picture"  tab, and click Select Picture.

5. Select a picture and click OK. Resize the Comment XE "Comment"  as appropriate. 

Convert XE "Convert"  Dates XE "Dates"  to Excel Formatted Dates

If you work with Excel, sooner or later you will encounter a problem with dates; particularly if these dates have been imported from another program. Let's look at some of the date formats that you may encounter and also how to convert these to standard Excel dates.

For all New XE "New"  Dates XE "Dates"  I will use the format: mm/dd/yy with a date that is 11-23-03.  The cells in column C have been formatted with a format of mm/dd/yy.

	 
	A
	B
	C

	1
	Imported Date
	Formula XE "Formula"  

Used
	New XE "New"  

Date

	2
	112303
	=VALUE(LEFT(A2,2)&"/"&MID(A2,3,2)&"/"&RIGHT(A2,2))
	11/23/03

	3
	031123
	=VALUE(MID(A3,3,2)&"/"&RIGHT(A3,2)&"/"&LEFT(A3,2))
	11/23/03

	4
	231103
	=VALUE(MID(A4,3,2)&"/"&LEFT(A4,2)&"/"&RIGHT(A4,2))
	11/23/03


For all New XE "New"  Dates XE "Dates"  I will use the format: dd/mm/yy with a date that is 23-11-03.  The cells in column C have been formatted with a format of dd/mm/yy (RSA DATE FORMAT)

	 
	A
	B
	C

	1
	Imported Date
	Formula XE "Formula"  

Used
	New XE "New"  

Date

	2
	112303
	=VALUE(MID(A2,3,2)&"/"&LEFT(A2,2)&"/"&RIGHT(A2,2))
	23/11/03

	3
	031123
	=VALUE(RIGHT(A3,2)&"/"&MID(A3,3,2)&"/"&LEFT(A3,2))
	23/11/03

	4
	231103
	=VALUE(LEFT(A4,2)&"/"&MID(A4,3,2)&"/"&RIGHT(A4,2))
	23/11/03


Using Text-To-Columns

If your dates are already in a text format eg: yy/mm/dd (031123), you can use the “Text XE "Text"  to Columns XE "Columns" ” feature of Excel.

1. Select the cells that house these dates (must be in one column in continuous rows)

2. Go to Data XE "Data" >Text XE "Text"  to Columns XE "Columns" .
3. Click Next twice to get to Step 3 of 3, ignoring any settings in steps 1 and 2.

4. Check Date under Column XE "Column"  data format and now select YMD from the drop-box

